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DISCLAIMER 

 
Please be aware of the loss, risk, personal or otherwise consequences of the use 
and application of this book’s content. The author and the publisher are not 
responsible for any actions that you undertake and will not be held accountable 
for any loss or injuries. 
 
U.S. Government Required Disclaimer - Commodity Futures Trading 
 
Commission Futures and Options trading has large potential rewards, but also large 
potential risks. You must be aware of the risks and be willing to accept them in order 
to invest in the futures and options markets. Don't trade with money you can't afford 
to lose. This is neither a solicitation nor an offer to Buy/Sell futures or options. No 
representation is being made that any account will or is likely to achieve profits or 
losses similar to those discussed on this website. The past performance of any 
trading software or methodology is not necessarily indicative of future results.  
 
 
CFTC RULE 4.41 - HYPOTHETICAL OR SIMULATED PERFORMANCE RESULTS 
HAVE CERTAIN LIMITATIONS. UNLIKE AN ACTUAL PERFORMANCE RECORD, 
SIMULATED RESULTS DO NOT REPRESENT ACTUAL TRADING. ALSO, SINCE 
THE TRADES HAVE NOT BEEN EXECUTED, THE RESULTS MAY HAVE 
UNDER-OR-OVER COMPENSATED FOR THE IMPACT, IF ANY, OF CERTAIN 
MARKET FACTORS, SUCH AS LACK OF LIQUIDITY. SIMULATED TRADING 
PROGRAMS IN GENERAL ARE ALSO SUBJECT TO THE FACT THAT THEY ARE 
DESIGNED WITH THE BENEFIT OF HINDSIGHT. NO REPRESENTATION IS 
BEING MADE THAT ANY ACCOUNT WILL OR IS LIKELY TO ACHIEVE PROFIT 
OR LOSSES SIMILAR TO THOSE SHOWN. 
 
 
No representation is being made that any account will or is likely to achieve profits 
or losses similar to those shown. In fact, there are frequently sharp differences 
between hypothetical performance results and the actual results subsequently 
achieved by any particular trading program. Hypothetical trading does not involve 
financial risk, and no hypothetical trading record can completely account for the 
impact of financial risk in actual trading. All information on this website or any e-
book purchased from this website is for educational purposes only and is not 
intended to provide financial advice. Any statements about profits or income, 
expressed or implied, do not represent a guarantee. Your actual trading may result 
in losses as no trading software is guaranteed. You accept full responsibilities for 
your actions, trades, profit or loss, and agree to hold SetForget Pattern Profit and 
any authorized distributors of this information harmless in any and all ways. The 
use of this software constitutes acceptance of this user agreement. 



COPYRIGHT 
 
This book and software cannot be re-written, re-published, STORED OR LINKED 
AT ANY FILE SHARING SITES or FORUMS or used for any other books without 
proper referencing without permission. The use of the book and software is limited 
to your personal use only. Spreading out the copies without the agreement of the 
development team is illegal and protected by international copyright law. 
 
Copyright © www.SetForgetPatternProfit.com 
 
Introduction 
 
Thank you for your purchase of “SetForget Pattern Profit”! 
 
SetForget Pattern Profit software package includes: 
 

- Step-by-step users guide  
 

- Indicator’s secret trading algorithm explained in detail  
 

- SetForget Pattern Profit indicator software itself  
 

- Live Actions Screenshots  
 

- Sample Trades examples  
 

- Personal "I will help you" promise from the developer  
 
 
―SetForget Pattern Profit‖ is an amazing indicator that generates accurate buy and 
sell arrows, plus shows 3 different TakeProfits and a StopLoss for each trade. You 
can choose any of the TakeProfits depending on your trading style. The indicator 
itself is based on some of the best and most profitable trading patterns. We chose 
the most promising patterns that we usually use in our trading. On top of that, the 
indicator is equipped with highly reliable filters and special additional algorithms to 
further improve the speed and accuracy of signals. I am sure you will enjoy trading 
with it. If you need help, please email me: karl@karldittmann.com 
 
I would love to help you!

 
It's extremely important for you to fully understand how  

SetForget Pattern Profit works. Read this guide carefully,  
it has a lot of important information that could greatly  

improve your trading experience. 
 
 



Please try using the indicator on a demo account first. Only move to trading 
with it on a live account, once you are completely familiar with SetForget 
Pattern Profit and fully understand all the simple rules on how to use it 
correctly. 
 
Do not hesitate to contact us if you have any questions! 
 
We wish you a great trading success! 
Karl Dittmann’s 

Trading Team 
 
www.SetForgetPatternProfit.com 
 
Installing the Indicator 

 
IMPORTANT: Make sure to update your MT4 to the latest build.  
SetForget Pattern Profit is designed to give you best results and to work 
properly only with the latest version of MT4 platform. 
 
 
If you don't have MetaTrader 4 ® 
installed, please download it from 
here: http://alpari.com 
 
Follow the instructions and open a demo or real account. We recommend 
trading on a demo account before proceeding to real live accounts.  
 

Unzip the zip file that you have downloaded:  
 
1) The indicator file is SetForgetPatternProfit.ex4  
2) The library file is SetForgetPatternProfit_Library_File.dll  
 
 
Broker Advice 
 
If you are not based in US, I recommend this broker: 
http://www.karldittmann.com/broker.php 
If you are based in US, then use this one: 

http://www.karldittmann.com/broker_usa.php 
 
Follow the instructions and open an account.  
We recommend trading on a demo account  
before proceeding to real live accounts. 
 
 
 
 

http://www.karldittmann.com/broker.php
http://www.karldittmann.com/broker_usa.php


MT4 installation instructions: 
 
 
Step 1: 
 
1) Open your MT4 platform  
 
2) Click File — Open Data Folder. Here you will find a folder called MQL4.  

 
3) Open folder MQL4. Here you will find Indicators folder. Copy your 
Indicator (ex4) file into MQL4/Indicators folder. Do this by right clicking on 
the file and  
clicking ―copy and then ―paste. 
 
4) Open folder MQL4 again. Here you will find Libraries folder. Copy your 
library (dll) file into MQL4/Libraries folder. Do this by right clicking on the 
file and clicking ―copy and then ―paste.  
 

5) Restart your MT4. 
 
If you have any difficulties, please contact me as soon as 
possible. My email is: karl@karldittmann.com 
 
 
Step 2: Open the MetaTrader® platform, 
and click on View -> Navigator. 
 
 
 
You can also press CTRL+N. 
 
 
 
 
 
 
 
 
 
 
 

 
Click on 'Navigator' 

 
 
 
Step 3: A window titled 'Navigator' will 
appear. Double click on Indicators. 
 
 
 
 
 
 



Step 4: You should see the SetForgetPatternProfit in the Indicators folder. Double 
click on the SetForgetPatternProfit file and click OK to load it onto your chart. 
 
Step 5: Once you attach SetForget Pattern Profit, make sure to enable the two options 
as shown below and only then click OK. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Step 6 (Important): Next you will see the activation window on your chart,  
as shown on the screenshot below. You will need to enter your receipt number 
to activate SetForget Pattern Profit. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Your receipt number is the Order ID generated by clickbank after your purchase 
of SetForget Pattern Profit. You need to copy/paste this number in the 

―Receipt number field and click ―Validate to activate the indicator on your system. 

 
You have 30-60 seconds to enter the receipt number. If you are out of time, 
simply try again by attaching the indicator to the chart once more. Be faster this 
time! 

 
Your order details are shown to you immediately after your purchase has been 
completed. Also this information will be sent to the email address you provided when 
purchasing. 



In case you entered a wrong email when purchasing, you can click the link as shown 
below to change your email address on file and resend the order details:  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

IMPORTANT: Please be advised that if you decide to request a 

refund, the indicator license will automatically deactivate. You 
will lose access to SetForget Pattern Profit and will no longer be 
able to use it! 
 
 
 
If you need any assistance, please contact our technical support 
team. Our email is:  karl@karldittmann.com 
 
Informer 

 
SetForget Pattern Profit has been enhanced with a smart informer system, which 
is designed to make your trading more pleasant and convenient. 
 
The informer shows: 

 

- Indicator name  
- Last Signal (BUY/SELL) 

- Time until next candle 

- Current time 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

mailto:karl@karldittmann.com


MUST READ RULES on how to use the signals 
 
 
Important Rule #1: 

 
Do not use the indicator on a flat market! Use the indicator ONLY 
at active market hours – for example London session, US session. 
 
Trend will not be noticeable on a weak market (night time, Christmas period,  
other holidays etc…) keep reading and I will explain everything... 
 
Important Rule #2: 
 
- Identify a global trend. (Remember? Trend is your friend!)   
- Ignore all signals against a current GLOBAL trend!  
 
Important Rule #3: 

 
The next highly important rule: Do not trade and do not use the 
indicator on a sideways trend. This is a ― MUST follow rule. 
 
If you DON’T follow or ignore the rules above – good results are 
NOT guaranteed! 
 
 
 
Stop Loss 
 
Option 1 (Recommended) 
 
Set your StopLoss according to StopLoss (SL) level  
that is shown on your chart as Blue or Yellow "X" symbol. 
 
The exact StopLoss Value is also shown in all types of signal alerts: 
(Popup alert, Email Alert and Push Notification Alert). 
 
Option 2 
 
A lot of traders usually calculate StopLoss with this formula: 
Previous bar high (for SELL entries) or low (for BUY entries) + spread + extra 
number of pips. 
 
IMPORTANT: Set stop loss for ALL your trades and DO NOT deviate from it. 
Once the trade has touched your stop loss, be disciplined and close the trade. 
This will protect you from major capital losses. 



Entering Trades 
 

 
BUY when a Blue Arrow appears. 
(As shown on the screenshot to your left) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
Sell when a Yellow Arrow appears. 
(As shown on the screenshot to your right) 



Exiting Trades 
 
Option 1 
 
Exit according to any of the Take Profit (TP1, TP2 or TP3)  
levels that are shown on your chart as Blue or Yellow Circles. 
 
The exact Take Profit Values are also shown in all types of signal alerts: 
(Popup alert, Email Alert and Push Notification Alert). 
 
Option 2 

 
Another exit mechanism which is highly effective is to exit near strong support 
or resistance levels. It is a method that generates exits earlier, so you take profits 
early. Good method if you prefer trading in a safer manner. 
 
 
Time Frames and Pairs 
 
-M15, M30, H1, H4 and D1 
 
-Works on all major pairs 
 
GBP/JPY, USD/CHF, USD/CAD, NZD/JPY, EUR/JPY – AVOID THESE! 
AUD/JPY, USD/JPY, GBP/USD, GBP/CAD, EUR/CAD – Good Results 
EUR/USD, EUR/AUD – Best Results (Recommended) 
 
If you follow all the trading rules or use our new special signal confirmation 
tool called ―Winning Signal Verifier‖ – almost any pair will bring great results! 
 
To get your own copy of ―Winning Signal Verifier‖, please visit this page: 
http://www.setforgetpatternprofit.net/winningsignalverifier.html

http://www.setforgetpatternprofit.net/winningsignalverifier.html


Signal Popup Alert Window: 

 
EURUSD, M5 – Pair, Timeframe 
BUY/SELL @ Price – Signal and Entry Price 
TP – Take Profit 
SL - Stop Loss 
 
 

Input Parameters: 
 
 

 
 
 
All the Inputs are ready to use/trade by default. You don’t have to 
change anything. Please read the next page for details on each 
parameter. 
                                                      
The first parameter is Info Position, which is responsible for moving the informer 
in any of the corners of your trading chart. It's useful to change this input when the 
info box is coming on top of the price and makes the signals hardly visible. 
 



Left upper – Upper Left Corner 
Right upper – Upper Right Corner 
Left lower – Bottom Left Corner 
Right lower – Bottom Right Corner 

 
Tip: If you want to remove the informer from the current chart, just set the 
corner value to Don't show info. To put it back on, use any other value. 
 
Info Text allows you to change the color of the informer’s text.  
Default – white. 
 
Show TP & SL Values is responsible for displaying values of the StopLoss 
and all 3 TakeProfits (for each signal) right next to their respective symbols on 
your chart. To switch this option on choose ―true‖ and to switch is off choose 
―false‖ 
 
If you wish you may change the sound (Pop-up Sound Alert) and email (Email 
Alert) alerts to true/false. By default, pop-up sound alert is set to "true" and email 
alert to "false". 
 
Push Alert is responsible for sending push notifications with all details  
about every signal to your mobile device. Push notification is set to "false" by 
default. This option can be turned on by selecting "true". 
 
Buy Color and Sell Color are responsible for changing the colors of buy and 
sell signal arrows, TPs and SL. These values will also change color of ―BUY‖ and 
―SELL‖ in the informer. 
 
Please continue reading to learn how to configure email alert and push notification.  
 
 
 
 
 

 
 

 



 
 

 
Most Profitable Recommended Products  

ever created by Karl Dittmann: 

 Click here to view Recommended Products List! 
 
 

Best forex software, strategies, scalpers and intraday 
indicators that will help you make great profit everyday 

with no trading experience! 
 

I guarantee you will find  
a lot of amazing indicators 
in this golden collection… 

 

/Karl Dittmann/ 
 

http://www.karldittmann.com/karl-dittmann-produts-full-list


EMAIL alert setup: 
 
Setup your MetaTrader4 to send email alerts: 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Email setup can be done in: Tools => Options => Email 
 
Email alert must be activated in the SetForget Pattern Profit INPUTS and Email 
must be enabled in MT4 options. Now, all you have to do is setup your own 
email server info. 
 
To find out what is your email server info, please Google 
―YOUR_EMAIL_PROVIDER_NAME Smtp Settings‖ and you will see all the 
required details. 

 
If you need more info on how to setup an email alert, please go to youtube.com 
and search for mt4 email setup. There are plenty of detailed explanation videos.



Push Notification Setup: 

 
Push notifications will be sent to your mobile device via MT4 app and they will 
include all the information about every signal generated by SetForget Pattern 
Profit. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
To set up push notifications, please follow these steps: 

 
1) Download and install MetaTrader 4 application from appstore or google 
play depending on the device you are using.  

 

2) Open the MetaTrader 4 application on your device -> Tap on ―Login To An 

Existing Account‖ -> Start entering your broker name and choose it from the 

dropdown list -> Enter your account Login and Password and tap ―Sign In‖ 

 

For IPhone: Go to Settings and tap ―Chat and Messages‖. At the bottom of the 

page you will see your MetaQuotes ID. Write it down as we will need this. 

 

For Android: Go to Settings, scroll down to Messages and you will see your 

MetaQuotes ID. Write it down as we will need this. 

 

 



3) Open MetaTrader 4 on your computer and go to Tools->Options-> Notifications. 
Enable "Enable Push Notifications", enter your MetaQuotes ID and click OK.  
 
4) Done! Attach SetForget Pattern Profit to a chart of your choice 
and enjoy push notifications sent directly to your mobile device!  
 
Please note: For push notifications to work, SetForget Pattern Profit must be 
attached to a chart, Push Alert in the indicator inputs must be set to "true", 
your computer and mobile device must be connected to the internet. 



Recommendations 
 

Use the indicator ONLY during ACTIVE market! 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Do not use the indicator on a weak/slow market – outside 
recommended trading hours (London or US sessions). Signals 
never work well on a weak market; this has been proven many 
times… 
 
 
The London session is the largest market 
and it opens at 08:00 GMT or 03:00 EST 
and closes at 17:00 GMT or 12:00 EST. 
 
Trading is best between 08:00 GMT and 10:00 GMT 
 
The New York session opens at 13:00 GMT  
or 08:00 EST and closes at 22:00 GMT or 17:00 EST. 
 
The best trades occur in the first 2-3 hours. 
 
The time is shown in 24:00 format. 

 
 

IMPORTANT: It is extremely important to trade only following the current trend!  

It will cut ALL bad trades! Avoid trading against trend at all times.  

 

Example: 

 
Trend is UP and the indicator shows ―Blue BUY Arrow – it’s ok to place a trade. 

 

Trend is UP and the indicator shows ― Yellow Sell Arrow – NO TRADE! 
Wait for the next ―BUY signal. 
 
Also, stay away from trading completely when the market is flat. 

 

Stay away from using the signals when you see unclear trend,  
flat or sideways trends – example: 

 
 
 
 
 
 

 
Please follow these just explained rules and all rules mentioned in this user guide 
to achieve best results. Don’t ignore them, they are designed to help you. 
 
 
 
 
 
 



Know Which Trades Will Win In Advance! 
 
 To help you identify flat/ranging market, 

know the best time to trade or when it’s 
better to avoid trading at all, we created a 
special supporting indicator tool called 
―Winning Signal Verifier‖.  

  
This indicator tool will show you all the 
important information about the current 
market conditions, so you know exactly 
which signals have the highest chance of 
winning.  

  
 If you use ―Winning Signal Verifier‖ you will 

know what signals to follow and what 
signals to avoid.  

  
 
To get your own copy of ―Winning Signal Verifier‖, please visit this page: 
http://www.setforgetpatternprofit.net/winningsignalverifier.html 
 
P.S. If you own ―Profit Trade Scanner‖ (another supporting indicator tool we’ve 
recently developed), please be informed that it is not suitable to work with 
―SetForget Pattern Profit‖.  ―SetForget Pattern Profit‖ uses a completely a new 
different trading approach and thus requires a new special fine-tuned supporting 
indicator such as ―Winning Signal Verifier‖ 
 
Money Management Tips 

 
Money management is a very important concept that has an enormous effect on 
draw downs and margin calls. The cardinal rule of money management is the 
following: 
 
You should only risk 1-3% of your account on any single trade. 

 
You may have heard this rule a hundred times before, but it is amazing to see how 
many good traders fail to comprehend this concept – and don't understand why 
they are wiped out again and again, despite great entries and timing of trades. 
 
Stoploss is calculated regardless of your level of risk or your equity, 
and is based solely on price-action. After a stop loss is set, calculate your trade 
size so you achieve the right percent of risk for your trades. 
 
For example: your stop loss is 10 pips, and your equity is 10,000$, you wish 
to risk 2% of your equity in this trade, so you enter a trade with 2 lots – so 
your risk is 200$, or 2%. 

http://www.setforgetpatternprofit.net/winningsignalverifier.html


More Actual Trades Example: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
Most Profitable Recommended Products  

ever created by Karl Dittmann: 

 Click here to view Recommended Products List! 

Best forex software, strategies, scalpers and intraday 
indicators that will help you make great profit everyday 

with no trading experience! 
 

I guarantee you will find  
a lot of amazing indicators 
in this golden collection… 

/Karl Dittmann/ 

 
 
Please contact me if you have any questions: karl@karldittmann.com  
I will do my best to help you as soon as possible. 
 
Best of Luck! 
Karl Dittmann 

http://www.karldittmann.com/karl-dittmann-produts-full-list

